User Guide

CellASIC™ ONIX Microfluidic Platform

EV262 Microfluidic System
MIC230 Microincubator Controller
GM230 Tri-Gas Mixer
Notice

The information in this document is subject to change without notice and should not be construed as a commitment by EMD Millipore Corporation ("Millipore") or an affiliate. Neither EMD Millipore Corporation nor any of its affiliates assumes responsibility for any errors that may appear in this document.

For research use only. Not for use in diagnostic procedures.

EV262 Microfluidic System
MIC230 Microincubator Controller

Made in USA
EMD Millipore Corporation
Hayward, CA 94545

The M logo and CellASIC are trademarks of Merck KGaA, Darmstadt, Germany. Millipore is a registered trademark of Merck KGaA. All trademarks of third parties are the property of their respective owners.

© 2012 EMD Millipore Corporation, Billerica, MA, USA. All rights reserved.
00003677, Rev. A, 10/12
Contents

1 Introduction to the CellASIC™ ONIX Microfluidic System ............................................. 1
  1.1 Overview .................................................................................................................. 1
  1.2 Benefits ..................................................................................................................... 1
  1.3 Environmental Control ............................................................................................ 2
  1.4 Applications ............................................................................................................. 2
  1.5 CellASIC™ ONIX Microfluidic Plate and Cell Type Compatibility ......................... 3
  1.6 Product Use Limitations .......................................................................................... 3

2 Components Required .................................................................................................. 3

3 Symbols Used in this User Guide .................................................................................. 4

4 Product Labeling ......................................................................................................... 4

5 Safety Precautions ...................................................................................................... 5

6 Installation ..................................................................................................................... 5
  6.1 Packaging .................................................................................................................. 5
  6.2 Site Requirements ................................................................................................... 6
  6.3 Software Installation ................................................................................................. 6
  6.4 CellASIC™ ONIX Microfluidic System Setup ........................................................... 7
  6.5 System Diagnostics ................................................................................................. 9
  6.6 Plate/Manifold Sealing ............................................................................................. 10
  6.7 Operation ................................................................................................................ 11

7 CellASIC™ ONIX FG Software Interface .................................................................... 11
  7.1 Plate Selection ........................................................................................................ 11
  7.2 Key Features and Functions ................................................................................... 12

8 CellASIC™ ONIX Microincubator Controller ............................................................... 23
  8.1 Introduction .............................................................................................................. 23
  8.2 CellASIC™ ONIX Microincubator Controller Setup ............................................... 24
  8.3 Temperature Calibration ......................................................................................... 26
  8.4 Plate-Manifold Sealing ............................................................................................ 28
  8.5 Operation ................................................................................................................ 28
9 CellASIC™ ONIX Tri-Gas Mixer ........................................................................ 30
  9.1 Tri-Gas Mixer Setup..................................................................................... 30
  9.2 Tri-Gas Mixer Examples............................................................................. 31
10 Troubleshooting ......................................................................................... 32
11 Storage, Maintenance, and Cleaning ......................................................... 34
  11.1 Storage...................................................................................................... 34
  11.2 Cleaning the CellASIC™ ONIX Microfluidic System and Microincubator Controller......................................................... 34
  11.3 Cleaning the Manifold and Gasket............................................................ 34
  11.4 Cleaning the Manifold Tubing (OPTIONAL)........................................... 34
12 Specifications ............................................................................................. 35
  12.1 EV262 Microfluidic System ..................................................................... 35
  12.2 MIC230 Microincubator Controller......................................................... 36
  12.3 GM230 Tri-Gas Mixer.............................................................................. 37
13 Ordering Information ................................................................................... 38
14 Technical Assistance ................................................................................... 39
15 EC Representative ......................................................................................... 39
16 Standard Warranty ....................................................................................... 39
1 Introduction to the CellASIC™ ONIX Microfluidic System

1.1 Overview

The CellASIC™ ONIX Microfluidic System uses microfluidic technology to enable continuous live-cell imaging with media flow. The proprietary design allows cells to be exposed to different solutions and conditions via pressurized flow channels controlled by user-specified time intervals and flow rates.

The microfluidic plate can be used with typical inverted microscopes and fits a standard multiwell plate stage. The CellASIC™ ONIX Microfluidic System connects to the microfluidic plate via a pneumatic manifold that uses pressurized air to pump cells and liquids from the plate wells into the microfluidic cell culture chambers. A vacuum seal created between the manifold and the microfluidic plate ensures that each well is independent and that flow rates and fluid switching are accurate. Flow control is managed through a computer software program.

This user guide covers the setup and operation of the CellASIC™ ONIX Microfluidic System (EV262), Microincubator Controller (MIC230), and Tri-Gas Mixer (GM230). User guides for the CellASIC™ ONIX Microfluidic Plates are available at www.millipore.com/cellasic.

![Figure 1. CellASIC™ ONIX Microfluidic System setup](image)

1.2 Benefits

- The CellASIC™ ONIX Microfluidic System provides a total solution for controlling the perfusion and gas environment for time-lapse, live-cell imaging applications.

- The CellASIC™ ONIX FG Software automates the entire experiment, allowing scheduled flow changes without supervision. Customized experiments can be performed by programming changes to media solutions, flow rates, and exposure times. The easy-to-use software is flexible and can generate simple solution switching protocols or advanced flow profiles.

- The precision laminar flow maintained by the system creates a highly stable environment for cells. The CellASIC™ ONIX Microfluidic System requires only microliter volumes of fluid and can run for multiple days without refilling.
1.3 Environmental Control

There are several temperature and gas control options for the CellASIC™ ONIX Microfluidic System. Please contact Technical Service for assistance in selecting the one that will work best with your specific setup and experiment.

If you already have or do not require temperature control, a defined gas environment can be delivered to the cell culture region by simply attaching a gas line flowing the desired gas mixture to the white Luer fitting on the manifold tubing. You can supply your own mixed gas (the gas must be at atmospheric pressure and regulated to a flow rate of 3–100 mL/min), or use the CellASIC™ ONIX Tri-Gas Mixer. Refer to section 9 for information on using the Tri-Gas Mixer.

Figure 2. Manifold and plate cutaway

The CellASIC™ ONIX Microincubator Controller and CellASIC™ ONIX Microincubator Manifold allow you to control both temperature and gas. This environmental control system takes advantage of the small size of the culture volume to efficiently, accurately, and conveniently maintain a precise cell culture environment. Refer to section 8 for information on using the Microincubator Controller and Manifold.

1.4 Applications

The CellASIC™ ONIX Microfluidic System is perfect for any perfusion-based application. The following are some common applications:

- Cell cycle analysis
- Protein localization
- GFP/CFP/YFP expression
- Kinetic responses to solution change
- Cell fixing and immunostaining
- 3D deconvolution
- Cell migration
- Long-term time-lapse imaging
- Apoptosis
- Mitosis
1.5 CellASIC™ ONIX Microfluidic Plate and Cell Type Compatibility

The Microfluidic Plates incorporate design templates that provide compatibility with a range of cell sizes and types as follows:

M04 Series Microfluidic Plates are compatible with any adherent or non-adherent mammalian cell line capable of culture on glass.

Examples: MCF-7, HeLa, NIH3T3, PC3, primary cells, stem cells

Y04 Series Microfluidic Plates are compatible with non-adherent cells that are 3.5–7 µm in diameter.

Examples: S. cerevisiae, S. pombe

B04 Microfluidic Plates are compatible with non-adherent cells that are 0.7–4.0 µm in diameter.

Examples: E. coli, B. subtilis, cyanobacteria

C04 Microfluidic Plates are compatible with non-adherent flagellates.

Example: Chlamydomonas

Please contact Technical Service for questions about cell types or coatings.

1.6 Product Use Limitations

The CellASIC™ ONIX Microfluidic System, Microincubator Controller, Tri-Gas Mixer, and Microfluidic Plates are intended for research use only. They are not for use in diagnostic procedures.

All due care and attention should be exercised in the handling of the products. Instructions provided in this manual should be followed when using CellASIC™ ONIX products.

If the equipment is used in a manner not specified by the manufacturer, protection provided by equipment may be impaired and the warranty may be voided.

2 Components Required

The following components for a functional system are included in the CellASIC™ ONIX Microfluidic Platform package. Refer to the Product Ordering section for additional manifolds, accessories, and other components.

<table>
<thead>
<tr>
<th>Component</th>
<th>Catalogue Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>CellASIC™ ONIX Microfluidic System</td>
<td>EV262</td>
</tr>
<tr>
<td>CellASIC™ ONIX Manifold</td>
<td>F84–GL3</td>
</tr>
<tr>
<td>CellASIC™ ONIX FG User Interface Software</td>
<td>ONIX-FG-SW</td>
</tr>
<tr>
<td>Accessory box for CellASIC™ ONIX EV262 Microfluidic System (includes diagnostic plate, syringe Luer adapter, input fittings)</td>
<td>ABN2</td>
</tr>
</tbody>
</table>
3 Symbols Used in this User Guide

The following symbols are used throughout this user guide and/or on product labels, and the user shall abide by indicated requirements:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Warning symbol" /></td>
<td>Warning alerts you to actions that may cause personal injury or pose a physical threat.</td>
</tr>
<tr>
<td><img src="image" alt="FCC symbol" /></td>
<td>Federal Communications Commission (FCC) conformity marking. This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communication. Operation of the equipment in a residential area is likely to cause harmful interference, in which case the user will be required to correct the interference at his own expense.</td>
</tr>
<tr>
<td><img src="image" alt="CE symbol" /></td>
<td>CE conformity marking. Reference Declaration of Conformity for specific directives.</td>
</tr>
<tr>
<td><img src="image" alt="WEEE symbol" /></td>
<td>Do not discard with common solid waste at end of life. Segregate with other waste electrical and electronic equipment (WEEE) and send to an appropriate facility for recycling. For information on recycling electrical and electronic products in the European Union, please visit <a href="http://www.millipore.com/weee">www.millipore.com/weee</a>.</td>
</tr>
</tbody>
</table>

4 Product Labeling

Figure 3. Product labels appear on backs of the components
5 Safety Precautions

Review and understand the safety precautions below before installing and operating the CellASIC™ ONIX Microfluidic System and Microincubator Controller.

⚠️ WARNING
- To avoid danger of electric shock, do not install the system in an area with a high humidity level. Refer to Site Requirements in section 6.
- Do not touch the cables or power plugs with wet hands.
- To avoid potential shock hazard, use the correct plug configuration and make sure that the power cable is plugged securely into a properly grounded AC power outlet. Make sure that the connection between the cable and the instrument is secure.
- Always ensure that the power supply input voltage matches the voltage available in your location.
- Use only the power cables supplied by EMD Millipore Corporation for use with the CellASIC™ ONIX Microfluidic System and Microincubator Controller. Use of other power cables may damage the system.
- Minimize power draw from other instruments on the same power circuit.
- Do not use with flammable or explosive liquids.
- Before cleaning and moving the system, always turn off power and unplug power supply.
- When working with biological material, always wear a suitable lab coat, disposable gloves, and eye protection. Proper lab safety should always be followed when using the system.

6 Installation

6.1 Packaging

Inspect the packaging for damage upon receipt. If there are any signs of damage, contact the responsible shipping company.

⚠️ WARNING: Do not put system components showing signs of damage into operation as this may result in severe personal injury and/or property damage.

Keep the original shipping boxes in case you need to return the system for servicing or repair.

NOTE: Instruments will not be accepted for repair if not in original packaging. EMD Millipore Corporation will provide shipping boxes for a charge if original packaging has been discarded.
6.2 Site Requirements

The CellASIC™ ONIX Microfluidic System and Microincubator Controller are designed for indoor laboratory use. The user must provide an installation site that meets the following requirements:

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Requirements</th>
</tr>
</thead>
</table>
| Space requirement               | Stable and horizontal base able to bear the weight of microfluidic system components and user-provided components  
Allow sufficient space so as not to block the ventilation holes on the sides and front of the system. |
| Environment                     | Temperature range: 15–30 °C  
Keep away from bright sunlight and high humidity. |
| Inductive electrical interference| Do not install the CellASIC™ ONIX Microfluidic System or Microincubator Controller near any sources of potential inductive electrical interference (e.g., pumps, switching motors, microwave ovens, etc.), sources of high energy pulses, or sources that might cause magnetic or radio frequency interference. |
| Power supply                    | Voltage range: 100–240 VAC  
Frequency range: 50/60 Hz  
Connect the CellASIC™ ONIX Microfluidic System and Microincubator Controller only to a grounded power outlet.  
Take precautions to ensure uninterrupted power supply if there is the potential for power supply issues (e.g., brownouts, power surges, frequent thunderstorms, etc.) |

6.3 Software Installation

In order to run this software, your computer must meet the requirements outlined below:

- Windows® XP or Windows® 7 operating system
- 1 GB RAM or higher
- 200 MB hard drive space or higher
- CD Drive, keyboard, mouse
- USB port

To install the CellASIC™ ONIX FG Software onto the computer, place the installation CD into the disc drive. Open the folder containing the software and click on **ONIX FG Installer→setup.exe**. An installation wizard guides you through the installation of the software. Simply follow the prompts.
6.3 Software Installation, continued

**NOTE:** Drivers for the Microfluidic System and Microincubator Controller typically install automatically when the systems are connected by USB and powered on. If a connection is not established automatically, the driver can be installed manually as follows:

1. Go to **Control Panel→Device Manager.**
2. Right click device **UM232R USB<->Serial** and select **Update Driver Software.**
3. Select **Browse my computer for driver software,** point the driver search at C:\Program Files\CellASIC ONIX FG and click **Next.**
4. After the driver is installed successfully, right click device **USB Serial Port** and select **Update Driver Software.**
5. Again, select **Browse my computer for driver software,** point the driver search at C:\Program Files\CellASIC ONIX FG, and click **Next.**

6.4 CellASIC™ ONIX Microfluidic System Setup

For Microincubator Controller and/or Tri-Gas Mixer setup, refer to sections 8 and 9.

Remove all components from shipping boxes and lay out on work surface.

1. Place the CellASIC™ ONIX Microfluidic System within 1–2 meters of an inverted microscope. For best results, locate the system on a flat surface and secure the manifold tubing so that it does not hinder stage movement. Ventilation holes on the front and sides of the system should not be obstructed.

2. Connect the power cord from a grounded electrical outlet to the system (D in Figure 4). The internal power supply accepts any voltage source between 100 and 240 VAC. Connect the USB cable from the computer to the USB port (A in Figure 4) on the back panel of the system.

**WARNING:** To avoid personal injuries and/or property damage caused by electrical power, connect the system and computer to a grounded power outlet. Make sure that this power outlet complies with IEC (International Electrotechnical Commission) regulations.

![Figure 4. CellASIC™ ONIX Microfluidic System back panel connection ports](image-url)
3. The CellASIC™ ONIX Microfluidic System has an internal pump to supply air and vacuum. A toggle switch (F in Figure 5) on the front of the system turns the vacuum on and off.

![CellASIC™ ONIX Microfluidic System front panel](image)

**Figure 5. CellASIC™ ONIX Microfluidic System front panel**

As an alternative for more quiet and stable operation, external air and vacuum lines can be connected at the back of the system. Air pressure input should be 2.1–6.9 bar (30–100 psi), and vacuum input higher than 711 millibar (21 in. Hg). If you wish to connect external air and vacuum, use the fittings provided in the accessory box (CPC 4 mm valved coupling insert). Attach the vacuum line to the Vacuum input (B in Figure 4) and the air line to the Pressure input (C in Figure 4) on the back of the system.

4. Attach the Luer fittings from the manifold to the Luer fittings on the front panel of the system in the correct order (Figure 6).

![Tubing attachment to system](image)

**Figure 6. Tubing attachment to system**

**Important:** Match each fitting to the corresponding line. Black fitting must be matched to black line (Figure 6).

The separate white fitting is for use with the CellASIC™ ONIX Microincubator Controller or Tri-Gas Mixer. If neither of these components is being used, this fitting does not need to be connected.

5. Turn on power switch (E in Figure 5). The blue Ready indicator (H in Figure 5) will light up when the unit is ready for operation.
6.5 System Diagnostics

To ensure that the system is installed and running properly, run the system diagnostic test.

1. Seal the manifold to the diagnostic plate supplied in the accessory box (refer to Plate/Manifold Sealing section that follows).

2. Open the CellASIC™ ONIX FG Software and go to System→System diagnostic (Figure 7).

Figure 7. System diagnostic

3. Enter the catalogue number (262) and serial number located on the back of the system. Click Run (Figure 8).

Figure 8. Enter serial number
6.5 **System Diagnostics**, continued

4. If all 5 status boxes are checked off, then the system is ready to go (Figure 9). Click on *Quit diagnostic* to leave this screen. If all the boxes are not checked off, save the results and contact Technical Service.

![System Diagnostics](image1.png)

**Figure 9. System ready to go**

6.6 **Plate/Manifold Sealing**

1. Wipe the F84 manifold gasket with 70% ethanol and dry with a lint-free cloth.
2. Place the microfluidic plate on a flat surface.
3. Align and set the manifold over the wells of the plate.
4. Make sure that the blue *Ready* light on the system is lit.
5. Turn the vacuum on (toggle switch up) and push down on the four manifold corners with slight force for ~5 seconds to ensure uniform contact during sealing (Figure 10). When a proper seal is formed, the green *Sealed* light will be lit.

![Plate/Manifold Sealing](image2.png)

**Figure 10. Sealing the plate to the manifold**

If this light does not appear, turn off the vacuum. Wait for the blue *Ready* light to turn back on, then repeat step 5. If a seal cannot be formed, contact Technical Service.

Make sure that a proper seal is formed before starting any experiment.

Leave the vacuum on during the course of the experiment.
6.7 Operation

1. Place the plate/manifold assembly on an inverted microscope. Focus on the center of the imaging area. (Figure 11). The culture chamber size varies from plate to plate. Refer to the specific plate User Guides for dimensions.

![Image of microfluidic plate imaging area]

Figure 11. Microfluidic plate imaging area

2. (Optional) Turn on carbon dioxide (CO$_2$) flow to the manifold. The CO$_2$ will fill the air channels in the microfluidic plate and diffuse through the gas permeable chamber walls.

3. Open the CellASIC™ ONIX FG Software on a computer and select the appropriate plate type (refer to section 7.1).

7 CellASIC™ ONIX FG Software Interface

The CellASIC™ ONIX FG Software is an easy-to-use interface for automating experimental protocols.

7.1 Plate Selection

After opening the CellASIC™ ONIX FG Software, select the plate of choice using the option tabs (Mammalian, Yeast, or Other) on the start screen (Figure 12). Each tab has multiple plate types below it.

![Image of CellASIC™ ONIX FG Software interface]

Figure 12. Plate selection
7.2 Key Features and Functions

The functions and features of the software will be demonstrated using the M04S plate. After this plate is selected from the start screen, a 2-part part window appears. The left side controls manual operation of valves V1–V8, and the right side provides various options for programming and running experimental protocols (Figure 13).

![Figure 13. M04S plate window](image)

7.2.1 Plate/Unit View

The FG software can be toggled between Plate View and Unit View by going to Options and choosing either Plate View or Unit View (Figure 14).

![Figure 14. Plate/Unit View Option](image)

Plate View: In the Plate View interface (Figure 14), the orange- and blue-colored bars labeled V1–V8 represent the eight controllable valves. Flow through each valve to the wells is set by clicking on the colored bar (when active, the bars appear darker in color) and adjusting the pressure using the flow gauges. The valves can also be keyboard-activated using the F1 through F8 keys.
7.2 Key Features and Functions, continued

Unit View: In the Unit View interface (Figure 15), the channel inlets for each solution are shown for each cell culture chamber. These can be turned on and off by clicking the valve (V) of interest or using the Shift F1 through Shift F8 keys.

![Figure 15. M04S plate window – Unit View](image)

Flow Gauges: The two flow gauges (Figure 15) control the pressure applied to the activated wells, resulting in a defined flow rate of a given solution. Two independent pressures can be set: Flow X corresponds to the pressure applied to the orange-colored valves V1 and V2. Flow Y corresponds to the pressure of the blue-colored valves V3–V8. Click and drag the flow gauge bar or type in the desired pressure to adjust the pressures. The pressures of Flow X and Y can be linked during manual operation by checking the linkage box (Figure 15).

System Status: The system status indicator (Figure 15) reports the system connectivity and microfluidic plate seal.

To close the Plate/Unit view and go back to the start screen, click File→Close plate interface (Figure 16).

![Figure 16. Close plate interface](image)
7.2 Key Features and Functions, continued

7.2.2 Command View

The right side of the interface window provides different options/tabs for programming and running experimental protocols (Figure 17).

![Command view](image)

Figure 17. Command view

**Manual Operation:** This tab allows the manual operation of the valves as described previously.

**Load Cells:** This tab allows you to create a program for loading a cell suspension into the culture chamber via well 6 (M04S, M04G) or via well 8 (Y04C, Y04D, B04A, C04A) (Figure 18).

**NOTE:** The **Load Cells** default settings are different for each plate type. Using the default setting specific to each plate is recommended, however, optimization may still be required depending on the cell type and/or concentration.

![Load Cells tab](image)

Figure 18. Load Cells tab
7.2 Key Features and Functions, continued

Create Protocol: This tab can be used to program experiments involving sequential, time-dependent solution exposure. You can specify the solution inlet valve (V1–V6), flow (psi), and duration of exposure (minutes) for each step of the experiment (Figure 19).

Set up the desired protocol parameters, then, if you wish to save the file, click on File→Save protocol.

Figure 19. Create Protocol tab
7.2 Key Features and Functions, continued

Click on the Create Protocol button, then click on OK (Figure 20). This will automatically take you to the Run Protocol tab.

NOTE: The protocol just created will not be “lost”. What will be overwritten is the previous protocol or default values.

Figure 20. Create Protocol button
7.2 Key Features and Functions, continued

Run Protocol: This tab converts your protocol into code recognized by the flow controller. Protocols created using the Create Protocol tab can be viewed and edited here (Figure 21). New protocols can also be written and saved, and previous protocols accessed by clicking File on the taskbar and choosing the desired action from the drop-down menu.

Figure 21. Run Protocol tab

To proceed, click on the Test button. The duration of the protocol (Figure 22) will appear in a popup window.

Figure 22. Protocol test button
7.2 Key Features and Functions, continued

To run the protocol, click on the Run button (Figure 23).

![Figure 23. Run Protocol button](image)

The program can be stopped or paused using the Stop and Pause buttons (Figure 24). Pausing the program allows the plate to be unsealed and removed from the manifold for addition/removal of solutions from the wells, if required.

![Figure 24. Stop and Pause buttons](image)
7.2 Key Features and Functions, continued

The plate can then be resealed to the manifold and the program resumed using the Resume button (Figure 25).

NOTE: When the program has been “paused”, you have the option to stop it entirely so that it can be aborted or restarted from the beginning, or to resume it where you left off.

Figure 25. Protocol stop and resume buttons
7.2 Key Features and Functions, continued

Plot View: During an experiment, the software will plot the history of perfusion sequences (Figure 26). To view, click on Options→Show Plot. The plot may also be exported using the command File→Export data (hotkey Ctrl+S).

Figure 26. Plot view

NOTE: If you are not using the Microincubator Controller, there will be no temperature plot.

7.2.3 Glossary of Commands:

The following commands are used to program experimental protocols.

<table>
<thead>
<tr>
<th>Command</th>
<th>Range</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>setflow X n</td>
<td>n = 0.25–10 (psi)</td>
<td>Sets flow on X (orange)</td>
</tr>
<tr>
<td>setflow Y n</td>
<td>n = 0.25–10 (psi)</td>
<td>Sets flow on Y (blue)</td>
</tr>
<tr>
<td>settemp n</td>
<td>n = 20–45 (°C)</td>
<td>Sets temperature for MIC230 Microincubator Controller</td>
</tr>
<tr>
<td>open Vn</td>
<td>n = 1, 2, 3, 4, 5, 6, 7, or 8</td>
<td>Opens pneumatic valve</td>
</tr>
<tr>
<td>close Vn</td>
<td>n = 1, 2, 3, 4, 5, 6, 7, or 8</td>
<td>Closes pneumatic valve</td>
</tr>
<tr>
<td>wait n</td>
<td>n = minutes</td>
<td>Holds current condition until next step</td>
</tr>
<tr>
<td>end</td>
<td>N/A</td>
<td>Ends the program; shuts off all valves and resets regulators</td>
</tr>
<tr>
<td>% (followed by space)</td>
<td>N/A</td>
<td>Put at the beginning of a line to create a comment</td>
</tr>
</tbody>
</table>
7.2 Key Features and Functions, continued

To vary flow rates between steps:

Insert the `setflow X n` or `setflow Y n` command before desired step. Use `setflow X n` to change the flow rate of solution in the wells controlled by V1 and V2 (i.e., A1–D1, and A2–D2). Use `setflow Y n` to change the flow rate of solution in the wells controlled by valves V3–V8 (i.e., A3–D3, A4–D4, A5–D5, A6–D6, A7–D7, and A8–D8). Use both commands in succession to change the flow rate of all wells.

**NOTE:** All subsequent steps will flow at the set rate. To revert back to a flow rate, you must insert additional `setflow` commands before the next step.

7.2.4 Sample protocol: Simple Solution Switching in Unit A

% Simple Solution Switching

% Well (A1) contains 300 µL red solution
% Well (A2) contains 300 µL orange solution
% Well (A3) contains 300 µL yellow solution
% Well (A4) contains 300 µL blue solution
% Well (A5) contains 300 µL purple solution
% Well (A6) contains 300 µL clear solution

% Constant flow rate pressure of 2 psi
setflow X 2.0000
setflow Y 2.0000

% Step 1: Expose chamber to red solution for 60 minutes
open V1
wait 60
close V1

% Step 2: Expose chamber to orange solution for 60 minutes
open V2
wait 60
close V2
7.2 Key Features and Functions, continued

% Step 3: Expose chamber to yellow solution for 60 minutes
open V3
wait 60
close V3

% Step 4: Expose chamber to blue solution for 60 minutes
open V4
wait 60
close V4

% Step 5: Expose chamber to purple solution for 60 minutes
open V5
wait 60
close V5

% Step 6: Expose chamber to clear solution for 60 minutes
open V6
wait 60
close V6

% End experiment protocol
end
8 CellASIC™ ONIX Microincubator Controller

8.1 Introduction

The CellASIC™ ONIX Microincubator Controller and Microincubator Manifold provide a convenient solution for temperature and gas environmental control to the CellASIC™ ONIX Microfluidic System.

Figure 27. CellASIC™ ONIX Microincubator Controller setup

Taking advantage of the small size and thermal mass of the system, temperature control is achieved using an on-manifold, bi-directional, convective heat exchange module where recirculating air gently and uniformly warms or cools the cells.

NOTE: For immersion objectives and air objectives with a working distance less than 0.5 mm, it is necessary to warm the objective using an objective heater.

Gas control is achieved using highly accurate external premixed gas sources. The system purges the cell culture region at a gas consumption rate of only 3 mL/minute.

Figure 28. Microincubator manifold and plate cutaway
8.2 CellASIC™ ONIX Microincubator Controller Setup

1. Place the Microincubator Controller under the Microfluidic System within 1–2 meters of an inverted microscope. For best results, locate both control boxes on a flat surface and secure the manifold tubing so that it does not hinder stage movement. Ventilation holes should not be obstructed.

2. Connect the power cord from a grounded electrical outlet to the Microincubator Controller (C in Figure 29). The internal power supply accepts any voltage source between 100 and 240 VAC. Connect the USB cable from the computer to the USB port (A in Figure 29) on the back panel of the controller.

![Figure 29. Back panel connection ports](image)

If gas environmental control is desired, connect a premixed gas tank to the back of the controller (B in Figure 29) using the fittings (CPC 4 mm valved coupling insert) provided in the Microincubator Controller accessory box. The pressure must be regulated between 3.1–3.8 bar (45–55 psi). When the Microincubator Controller is powered on, consumption of the gas mixture will be approximately 3 mL/min.

**NOTE:** Use low gas-permeable tubing such as polyurethane or polyethylene. **DO NOT** use vinyl or silicone tubing.

3. Attach the Luer fittings from the Microincubator Manifold to the Luer fittings on the front panel of the system in the correct order. Refer to Figure 6.

**Important:** Match each fitting to the corresponding line. Black fitting must be matched to black line.

Attach the white Luer fitting to the white **Gas Out** fitting (I in Figure 30) on the front panel of the Microincubator Controller. To connect the 6-conductor plug from the Microincubator Manifold, align the red marks and push into the socket labeled **To Heater** (H in Figure 30) on the front of the controller. The plug can be removed by pulling on the sheath.
8.2 CellASIC™ ONIX Microincubator Controller Setup, continued

To confirm communication between the computer and the Microincubator Controller, open the CellASIC™ ONIX FG Software and go to System→Reset communication. A pop-up window will indicate successful communication with both the EV262 and MIC230 control boxes (Figure 31).

---

Figure 30. CellASIC™ ONIX Microfluidic System and Microincubator Controller front panels

Figure 31. Confirming Microincubator Controller communication with computer
8.3 Temperature Calibration

A Temperature Calibration Plate is included in the accessory box provided with the Microincubator Controller. The Calibration Plate is used to confirm that the cell culture region is being maintained at the desired temperature despite room temperature variation and the heat sink capacity of the microscope objectives.

Attach the Temperature Calibration Plate USB cable to the USB port of the computer.

To install the DirecTemp™ temperature monitoring software, place the CellASIC™ ONIX FG Software installation CD into the disc drive. Go to Temperature Calibration Plate Installer → Installer and click on DirecTempInstaller. Follow the installation wizard prompts to complete the installation of the DirecTemp™ software.

Follow these steps to determine the correct Microincubator Controller setpoint for your experiment.

8.3.1 For air objectives with working distance greater than 0.5 mm:

1. Seal the Microincubator Manifold to the Temperature Calibration Plate as in section 6.6.

2. Place the manifold and plate onto the microscope stage and set up the microscope as it will be set up for the cell-based experiment. Correctly position the objective and condenser, and move the stage and objective to focus on the features within the imaging region of the Temperature Calibration Plate.

3. Close the CellASIC™ ONIX FG Software and open the DirecTemp™ software (C:\Program Files\QTI\DirectTemp). This software allows you to monitor the Calibration Plate temperature as it stabilizes.

4. Turn on the Microincubator Controller and adjust the setpoint using the up and down arrows (E in Figure 30) on the controller front panel, until the readout displays the desired temperature for the experiment.

   NOTE: While you are adjusting the temperature with the up and down arrows, the setpoint temperature is displayed on the controller (F in Figure 30). A few seconds after you stop adjusting the temperature, the current temperature of the Microincubator Manifold is displayed.
8.3 Temperature Calibration, continued

5. Allow the temperature of the Temperature Calibration Plate to stabilize. This may take up to 20 minutes and can be monitored in the DirecTemp™ software (Figure 32). If the stabilized temperature of the plate is not at the desired temperature for the experiment, adjust the setpoint up or down and wait for stabilization. Several adjustment/stabilization cycles may be required to bring the Calibration Plate temperature to the desired temperature. The temperature required to bring the Calibration Plate to the desired experimental temperature is the Microincubator Controller setpoint you will use for your experiment.

8.3.2 For immersion objectives and air objectives with working distance less than 0.5 mm:

Objective heater required!

1. Seal the Microincubator Manifold to the Temperature Calibration Plate as in section 6.6.

2. Place the manifold and plate onto the microscope stage and set up the microscope as it will be set up for the cell-based experiment. Correctly position the condenser and stage, but do not have the objective near the plate.

3. Follow steps 3–5 in section 8.3.1 to determine the Microincubator Controller setpoint.

4. Bring the objective close and focus on the features within the imaging region of the Temperature Calibration Plate. Adjust the setpoint of your objective heater until the Temperature Calibration Plate is again at the desired temperature. Stabilization time depends on the objective heater. Use this objective heater setpoint for your experiment.
8.4 Plate-Manifold Sealing

Seal the Microincubator Manifold to the microfluidic plate as indicated in section 6.6.

8.5 Operation

1. Turn the Microincubator Controller power switch on to begin heating or cooling the manifold.

If pressurized gas is supplied to the back of the Microincubator Controller, gas will flow from Gas Out while the power switch is on. A green Gas Flow indicator light (G in Figure 30) confirms that there is gas flow.

**IMPORTANT:** Due to the low gas flow rate (3 mL/min), the system needs approximately 10 minutes to stabilize and provide a correct indication of gas flow status.

2. Open the CellASIC™ ONIX FG Software and choose the appropriate plate type.

**NOTE:** When the Microincubator Controller is connected to the system, the Set, Read, and Protocol set temperature boxes are enabled (Figure 33), and adjustments cannot be made manually on the controller.

![Figure 33. CellASIC™ ONIX FG Software temperature control](image)

3. Using the software, adjust the Microincubator Controller setpoint to the temperature determined from the Temperature Calibration Plate as follows:

**Manual Operation** tab: Click on the Set temperature up and down arrows or type in the desired value on the left side of the screen.
8.5 Operation, continued

Create Protocol tab: Type the desired temperature into the box next to Protocol set temperature on the right side of the screen.

Run Protocol tab: Enter as command "settemp n" on the right side of the screen (refer to section 7.2.3).

NOTE: The setpoint temperature input on the right hand side of the screen in either the Create Protocol or Run Protocol tabs will override the Set temperature on the left side of the screen as soon as you click on the Run button.
9 CellASIC™ ONIX Tri-Gas Mixer

9.1 Tri-Gas Mixer Setup

![CellASIC™ ONIX Tri-Gas Mixer setup](image)

**NOTE:** Flow meter accuracy and stability are dependent on the pressure stability of gas inputs, levelness of surface, and degree of temperature fluctuation.

1. Place Tri-Gas Mixer close to the CellASIC™ ONIX Microfluidic System on a level surface.

2. Turn knobs all the way off before flowing gases.

   **IMPORTANT:** Make sure that the knobs are always completely shut off before connecting gas lines. If a particular gas line is not in use, keep the knob shut at all times to ensure accuracy of measurement.

3. Connect external gas lines to corresponding inlets on the back of the Tri-Gas Mixer using the fittings provided.

4. Attach the Luer fittings from the manifold to the Luer fittings on the front panel of the system in the correct order. Refer to Figure 6.

   **Important:** Match each fitting to the corresponding line. Black fitting must be matched to black line.

5. Attach white Luer fitting from the manifold to Tri-Gas Mixer outlet (Figure 35).

![Manifold to Tri-Gas Mixer connection](image)
9.1 Tri-Gas Mixer Setup, continued

6. Start turning the knobs counterclockwise on flow meters to set each gas to desired flow rate ratio. For most accurate flow measurement, set ratio to upper limit of flow.

7. Wait one hour for flow meter readings to stabilize. Make adjustments if necessary. Check/readjust flow every 72 hours to prevent drift.

9.2 Tri-Gas Mixer Examples

9.2.1 5% CO₂

1. Follow setup instructions in section 9.1.

2. Set flow meters as indicated in Figure 36.

   ![Flow Meters Figure 36](image)

   Set either air OR N₂ (for anoxic condition) flow rate to 95 mL/min
   Set CO₂ flow rate to 5 mL/min

Figure 36. Flow setting example 1; 5% CO₂

9.2.2 Hypoxic Condition 1% O₂, 5% CO₂

1. Follow setup instructions in section 9.1.

2. Set flow meters as indicated in Figure 37.

   ![Flow Meters Figure 37](image)

   Set air flow to rate to 5 mL/min*
   Set N₂ flow to rate to 90 mL/min
   Set CO₂ flow rate to 5 mL/min

Figure 37. Flow setting example 2; Hypoxic condition 1% O₂, 5% CO₂

* Concentration of O₂ in air is 20.9%
### Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Microfluidic plate does not seal or leakage error message occurs</td>
<td>Manifold not settled properly around plate</td>
<td>Align gasket hole-to-hole with manifold. Place lip of manifold over microfluidic plate properly.</td>
</tr>
<tr>
<td></td>
<td>Gasket not aligned properly</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Debris on gasket</td>
<td>Clean gasket as indicated in section 11.3. Always use a lint-free cloth when wiping or blotting gasket.</td>
</tr>
<tr>
<td></td>
<td>Vacuum reservoir empty (Blue Ready indicator light is not illuminated)</td>
<td>Switch <strong>Plate Seal</strong> switch to off position and allow vacuum indicator light to reestablish.</td>
</tr>
<tr>
<td></td>
<td>Manifold cracked or possible air leakage out of manifold</td>
<td>Run diagnostic program, save results, and contact Technical Service.</td>
</tr>
<tr>
<td></td>
<td>Luer fittings not in correct order</td>
<td>Connect Luer fittings consecutively along the length of the panel.</td>
</tr>
<tr>
<td></td>
<td>Plate leakage</td>
<td>Check plate for cracks. If cracks are found, contact Technical Service.</td>
</tr>
<tr>
<td>2. Software unresponsive</td>
<td>Interrupted communication between PC and CellASIC™ ONIX Microfluidic System</td>
<td>Unplug and replug USB cable to re-establish USB connection, then restart software on PC. Go to <strong>System → Reset Communication.</strong></td>
</tr>
<tr>
<td>3. Loud buzzing from CellASIC™ ONIX Microfluidic System</td>
<td>Plate not sealed correctly</td>
<td>See Symptom #1.</td>
</tr>
<tr>
<td></td>
<td>Electronic controllers need calibration</td>
<td>Turn system off and on. Seal plate to manifold. Perform calibration by clicking on <strong>System → Calibration sequence</strong> in the CellASIC™ ONIX FG Software.</td>
</tr>
<tr>
<td>4. CellASIC™ ONIX Microfluidic System turns off unexpectedly</td>
<td>Internal pump overheated (possible cause: vacuum switch left on when there was no plate sealed to manifold)</td>
<td>Allow system to cool for an hour before turning on again. Before operating, check manifold seal. Always turn vacuum off when there is no plate on the manifold.</td>
</tr>
<tr>
<td>5. Fluid in the manifold lines</td>
<td>Culture chamber outlet wells were not emptied and they overflowed</td>
<td>During extended experiments, pause the protocol and empty the chamber outlet wells. Refer to section 7.2.2. Clean tubing according to section 11.4.</td>
</tr>
<tr>
<td>6. Microincubator Controller not recognized by or communicating with software</td>
<td>Interrupted communication between PC and Microincubator Controller</td>
<td>Unplug and replug USB cable to re-establish USB connection, then restart software on PC. Go to <strong>System → Reset Communication.</strong></td>
</tr>
<tr>
<td>7. Microincubator temperature control will not reach setpoint</td>
<td>Potential issue with heat exchanger module</td>
<td>Contact Technical Service.</td>
</tr>
</tbody>
</table>
## 10 Troubleshooting, continued

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>8. Microincubator gas flow indicator does not illuminate</td>
<td>Insufficient time for a correct reading</td>
<td>Wait 10 minutes and if indicator light remains off, check for other causes.</td>
</tr>
<tr>
<td></td>
<td>No gas connected to controller</td>
<td>Connect 3.1–3.8 bar (45–55 psi) gas to back of system.</td>
</tr>
<tr>
<td></td>
<td>Manifold tubing is pinched</td>
<td>Ensure that tubing is not pinched and that gas flow is unobstructed.</td>
</tr>
</tbody>
</table>

If these corrective actions do not resolve the issue, run the diagnostic test (section 6.5). Save the results and contact Technical Service.
11 Storage, Maintenance, and Cleaning

**WARNING**

Perform only the maintenance procedures described in this manual and observe the relevant safety precautions. **Failure to do so may cause property damage or personal injury.**

Maintenance or repair procedures not described in this manual should be performed only by an EMD Millipore Corporation service engineer. Tampering with or alterations to the CellASIC™ ONIX Microfluidic System, Microincubator Controller, Manifolds and/or other components may void the warranty. Refer to the Technical Assistance section for information on contacting Technical Service.

11.1 Storage

Store at 5–45 °C in an upright position.

11.2 Cleaning the CellASIC™ ONIX Microfluidic System and Microincubator Controller

Wipe control boxes clean of dust and remove any possible obstruction to ventilation. Do not allow liquid to enter the system while cleaning.

11.3 Cleaning the Manifold and Gasket

Remove the gasket from manifold periodically and clean gently with soap and water. Rinse with distilled water and/or 70% ethanol and shake off excess liquid. Lay gasket back onto manifold with holes properly aligned and allow to air dry. Do not stretch gasket during alignment.

For sanitization prior to experiment, wipe gasket and manifold lightly (i.e., do not soak) with 70% ethanol and blot dry with a lint-free cloth.

**NOTE:** Manifold components are not autoclavable.

The glass on the top of the Microincubator Manifold can be gently cleaned with 70% ethanol or a glass cleaner.

11.4 Cleaning the Manifold Tubing (OPTIONAL)

Fill a 10 mL syringe with distilled water or 70% ethanol and use the Luer adaptor provided in the accessory box to connect the syringe to the manifold’s multi-line tubing. Push fluid through each tubing line. To dry, fill syringe with air and push out residual fluid.

**CAUTION:** When cleaning the Microincubator Manifold tubing, keep the manifold right side up and level, and do not expose the heat exchange module to liquid.

**NOTE:** If fluid enters the manifold tubing during the course of an experiment, it should be cleaned as described above.
## 12 Specifications

### 12.1 EV262 Microfluidic System

#### General

<table>
<thead>
<tr>
<th>Dimension</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions</td>
<td>310 mm wide × 257 mm deep × 113 mm high (12.2 in. × 10.1 in. × 4.4 in.)</td>
</tr>
<tr>
<td>Weight</td>
<td>Controller: 5.4 kg (11.9 lb) Manifold: 0.12 kg (0.26 lb)</td>
</tr>
<tr>
<td>Power consumption</td>
<td>100–240 VAC, 50/60 Hz</td>
</tr>
<tr>
<td>Power rating</td>
<td>40 W</td>
</tr>
<tr>
<td>Cooling mode</td>
<td>Air cooled (natural convection)</td>
</tr>
</tbody>
</table>
| Environmental conditions | Operating temperature: 15 °C to 30 °C  
                          | Storage temperature: 5 °C to 45 °C                                  |

#### Outputs

<table>
<thead>
<tr>
<th>Output</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of outputs</td>
<td>8</td>
</tr>
<tr>
<td>Pressure range</td>
<td>0–0.7 bar (0–10 psi)</td>
</tr>
<tr>
<td>Pressure accuracy</td>
<td>10.3 mbar (±0.25 psi)</td>
</tr>
<tr>
<td>Pressure stabilization time</td>
<td>&lt; 5 seconds</td>
</tr>
</tbody>
</table>

#### Optional inputs

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pressure supply</td>
<td>Clean, dry air, nitrogen (N₂), or argon regulated between 2.1 and 6.9 bar (30 and 100 psi).</td>
</tr>
<tr>
<td>Vacuum</td>
<td>Steady vacuum regulated between 711 millibar (21 in. Hg) and perfect vacuum</td>
</tr>
<tr>
<td>Gas mixture</td>
<td>Flow rate of 3–100 mL/min</td>
</tr>
</tbody>
</table>

#### Cell Culture Region Gas Environment Accuracy

- For gas flow at 3 mL/min: < 10% deviation from delivered gas
- For gas flow at 20 mL/min: < 2% deviation from delivered gas

#### Computer Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows® XP or Windows® 7</td>
</tr>
<tr>
<td>Random access memory (RAM)</td>
<td>1 GB or higher</td>
</tr>
<tr>
<td>Hard drive</td>
<td>200 MB or higher</td>
</tr>
<tr>
<td>Hardware interface</td>
<td>USB 1.0 or higher</td>
</tr>
<tr>
<td></td>
<td>CD drive, keyboard, mouse</td>
</tr>
</tbody>
</table>

#### Manifold Materials of Construction

<table>
<thead>
<tr>
<th>Component</th>
<th>Material</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manifold body</td>
<td>Cyclic olefin copolymer</td>
</tr>
<tr>
<td>Gasket</td>
<td>Silicone</td>
</tr>
<tr>
<td>Tubing/fittings</td>
<td>Polyurethane, polycarbonate, nylon, stainless steel</td>
</tr>
</tbody>
</table>
# 12.2 MIC230 Microincubator Controller

## General

<table>
<thead>
<tr>
<th>Dimension</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions</td>
<td>310 mm wide × 257 mm deep × 50 mm high (12.2 in. × 10.1 in. × 2.0 in.)</td>
</tr>
<tr>
<td>Weight</td>
<td>Controller: 2.7 kg (6 lb)</td>
</tr>
<tr>
<td></td>
<td>Manifold: 0.26 kg (0.57 lb)</td>
</tr>
<tr>
<td>Power consumption</td>
<td>100–240 VAC, 50/60 Hz</td>
</tr>
<tr>
<td>Power rating</td>
<td>40 W</td>
</tr>
<tr>
<td>Cooling mode</td>
<td>Air cooled (natural convection)</td>
</tr>
<tr>
<td>Environmental conditions</td>
<td>For indoor laboratory use</td>
</tr>
<tr>
<td></td>
<td>Operating temperature: 15 °C to 30 °C</td>
</tr>
<tr>
<td></td>
<td>Storage temperature: 5 °C to 45 °C</td>
</tr>
</tbody>
</table>

## Temperature Control

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature control range</td>
<td>Room temperature to 40 °C</td>
</tr>
<tr>
<td>Control method</td>
<td>Bi-directional PID</td>
</tr>
<tr>
<td>Set method</td>
<td>Up and down keys, increment 0.1 °C</td>
</tr>
<tr>
<td>Achievable stability</td>
<td>± 0.2 °C</td>
</tr>
<tr>
<td>Rise time (25 °C to 37 °C)</td>
<td>&lt; 10 minutes</td>
</tr>
<tr>
<td>Cooling time (37 °C to 25 °C)</td>
<td>&lt; 15 minutes</td>
</tr>
<tr>
<td>Calibration plate accuracy</td>
<td>± 0.1 °C</td>
</tr>
</tbody>
</table>

## Optional gas flow

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flow rate</td>
<td>3.0 mL/min typical, ± 0.5 mL/min</td>
</tr>
<tr>
<td>Premixed gas input</td>
<td>Clean, dry, premixed gas containing air, CO₂, N₂, and oxygen (O₂) up to 25%, regulated to 3.1–3.8 bar (45–55 psi)</td>
</tr>
</tbody>
</table>

## Cell Culture Region Gas Environment Accuracy

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>For gas flow at 3 mL/min</td>
<td>&lt; 10% deviation from delivered gas</td>
</tr>
<tr>
<td>For gas flow at 20 mL/min</td>
<td>&lt; 2% deviation from delivered gas</td>
</tr>
</tbody>
</table>

## Computer Requirements

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows® XP or Windows® 7</td>
</tr>
<tr>
<td>Hardware interface</td>
<td>USB 1.0 or higher</td>
</tr>
</tbody>
</table>

## Manifold Materials of Construction

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manifold body</td>
<td>Cyclic olefin copolymer</td>
</tr>
<tr>
<td>Gasket</td>
<td>Silicone</td>
</tr>
<tr>
<td>Tubing/fittings</td>
<td>Polyurethane, polycarbonate, nylon, stainless steel</td>
</tr>
</tbody>
</table>
### 12.3 GM230 Tri-Gas Mixer

#### General

<table>
<thead>
<tr>
<th>Dimension</th>
<th>161.3 mm wide × 151.2 mm deep × 183.6 mm high (6.4 in. × 6.0 in. × 7.2 in.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>2.1 kg (4.6 lb)</td>
</tr>
<tr>
<td>Environmental conditions</td>
<td>For indoor laboratory use</td>
</tr>
<tr>
<td></td>
<td>Operating temperature: 15 °C to 30 °C</td>
</tr>
<tr>
<td></td>
<td>Storage temperature: 5 °C to 45 °C</td>
</tr>
<tr>
<td>Gas supply requirements</td>
<td>Compressed air, N₂, and CO₂</td>
</tr>
<tr>
<td></td>
<td>Clean and dry, &gt;99.5% pure</td>
</tr>
<tr>
<td></td>
<td>Regulated to 2.1–6.9 bar (30–100 psi)</td>
</tr>
<tr>
<td>Gas supply consumption</td>
<td>Air, 0–100 mL/min</td>
</tr>
<tr>
<td></td>
<td>N₂, 0–120 mL/min</td>
</tr>
<tr>
<td></td>
<td>CO₂, 0–10 mL/min</td>
</tr>
</tbody>
</table>

#### Outputs

| Mixed gas            | 0% or 1–21% O₂                                                                 |
|                      | 0% or 1–15% CO₂                                                                |
| Flow meter accuracy  | ±2% of full scale at 21 °C                                                      |
| Flow meter stability | ±0.20% CO₂ per 1 °C*                                                           |
| Flow meter drift     | ±0.1% CO₂ per day*                                                             |

* Example application at 5% CO₂ and ±4 °C thermal oscillation
### Ordering Information

This section lists catalogue numbers for the CellASIC™ ONIX products. See Technical Assistance section for contact information. You can purchase these products on-line at [www.millipore.com/products](http://www.millipore.com/products).

<table>
<thead>
<tr>
<th>Product Description</th>
<th>Cat. No.</th>
<th>Qty/Pk</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CellASIC™ ONIX Microfluidic System</strong></td>
<td>EV262</td>
<td>1</td>
</tr>
<tr>
<td><strong>CellASIC™ ONIX Microincubator Controller</strong></td>
<td>MIC230</td>
<td>1</td>
</tr>
<tr>
<td><strong>CellASIC™ ONIX Tri-Gas Mixer</strong></td>
<td>GM230</td>
<td>1</td>
</tr>
<tr>
<td><strong>CellASIC™ ONIX Manifolds</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manifold for use with CellASIC™ ONIX plates, small for deep well plate holders</td>
<td>F84–GL2</td>
<td>1</td>
</tr>
<tr>
<td>Manifold for use with CellASIC™ ONIX plates</td>
<td>F84–GL3</td>
<td>1</td>
</tr>
<tr>
<td>Manifold for use with CellASIC™ ONIX plates, for DIC imaging</td>
<td>F84–DL3</td>
<td>1</td>
</tr>
<tr>
<td>Manifold with recirculating heat exchanger, for use with CellASIC™ ONIX plates and Microincubator Controller</td>
<td>F84–HG3</td>
<td>1</td>
</tr>
<tr>
<td><strong>CellASIC™ ONIX Software</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CellASIC™ ONIX FG User Interface Software</td>
<td>ONIX-FG-SW</td>
<td>1</td>
</tr>
<tr>
<td>CellASIC™ ONIX µManager and ImageJ Plugin</td>
<td>ONIX-UMP-SW</td>
<td>1</td>
</tr>
<tr>
<td><strong>CellASIC™ ONIX Microfluidic Plates</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CellASIC™ ONIX switching plate for mammalian cells (4-chamber)</td>
<td>M04S-03-5PK</td>
<td>5</td>
</tr>
<tr>
<td>CellASIC™ ONIX open-top plate for mammalian cells (4-chamber)</td>
<td>M04L-03-5PK</td>
<td>5</td>
</tr>
<tr>
<td>CellASIC™ ONIX gradient plate for mammalian cells (4-chamber)</td>
<td>M04G-02-5PK</td>
<td>5</td>
</tr>
<tr>
<td>CellASIC™ ONIX plate for haploid yeast cells (4-chamber, trap heights of 3.5, 4.0, and 4.5 µm)</td>
<td>Y04C-02-5PK</td>
<td>5</td>
</tr>
<tr>
<td>CellASIC™ ONIX plate for diploid yeast cells (4-chamber, trap heights of 5, 6, and 7 µm)</td>
<td>Y04D-02-5PK</td>
<td>5</td>
</tr>
<tr>
<td>CellASIC™ ONIX plate for bacteria cells (4-chamber, trap heights of 0.7, 0.9, 1.1, 2.0, 3.0, and 4.0 µm)</td>
<td>B04A-02-5PK</td>
<td>5</td>
</tr>
<tr>
<td>CellASIC™ ONIX plate for Chlamydomonas cells (4-chamber, chamber height of 5 µm with 4 µm pocket)</td>
<td>C04A-01-5PK</td>
<td>5</td>
</tr>
</tbody>
</table>
13 Ordering Information, continued

<table>
<thead>
<tr>
<th>Product Description</th>
<th>Cat. No.</th>
<th>Qty/Pk</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CellASIC™ ONIX Microfluidic System Replacement Parts/Accessories</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Premixed gas regulator (for use with 103 L or 112 L cylinders with a C10 connection)</td>
<td>GR02</td>
<td>1</td>
</tr>
<tr>
<td>Temperature calibration plate</td>
<td>TCP1-F84</td>
<td>1</td>
</tr>
<tr>
<td>Diagnostic plate</td>
<td>DP1</td>
<td>1</td>
</tr>
<tr>
<td>Humidity bottle</td>
<td>HB01</td>
<td>1</td>
</tr>
<tr>
<td>Accessory box for MIC230 Microincubator Controller (includes temperature calibration plate, input fitting)</td>
<td>ABI1</td>
<td>1</td>
</tr>
<tr>
<td>Accessory box for EV262 Microfluidic System (includes diagnostic plate, syringe Luer adapter, input fittings)</td>
<td>ABN2</td>
<td>1</td>
</tr>
<tr>
<td>Replacement gasket for F84-DL3 manifold</td>
<td>F84DL3-GK</td>
<td>1</td>
</tr>
<tr>
<td>Replacement gasket for F84-GL2 manifold</td>
<td>F84GL2-GK</td>
<td>1</td>
</tr>
<tr>
<td>Replacement gasket for F84-GL3 manifold</td>
<td>F84GL3-GK</td>
<td>1</td>
</tr>
<tr>
<td>Replacement gasket for F84-HG3 manifold</td>
<td>F84HG3-GK</td>
<td>1</td>
</tr>
</tbody>
</table>

14 Technical Assistance

For more information, contact the office nearest you. In the U.S., call 1-800-MILLIPORE (1-800-645-5476). Outside the U.S., go to our web site at www.millipore.com/offices for up-to-date worldwide contact information. You can also visit the tech service page on our web site at www.millipore.com/techservice.

15 EC Representative

Millipore (UK) Ltd.
Fleming Road, Kirkton Campus
Livingston EH54 7BN
UK

16 Standard Warranty

The applicable warranty for the products listed in this publication may be found at www.millipore.com/terms (within the “Terms and Conditions of Sale” applicable to your purchase transaction).